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1. Before You Begin

Welcome to the FAA eForm Service Help system. This system will guide you through the different
aspects of using the electronic forms. It will walk you through Form Manager, provide answers to
general questions, cover system access, and much more.

If you have any problems, please feel free to contact the AVS National Service Desk (NSD) 24
hours/7days a week.

Phone: 1-877-AVS-NSD1 (1-877-287-6731)
Email: AVS National Service Desk

2. System Requirements

The following operating system has been tested and certified to work with the eForm Service and
subsequent forms. Therefore, we can provide user support only for this environment.

Windows Platforms (Supported by Aviation Safety)

e Adobe Acrobat 9.3.1 (or later) or Adobe Reader v9.1.1 (or later)
e Adobe Flash Player v10.0.22.87 (or later)

e Intel 1.3 GHz processor

e Microsoft Windows XP Professional or Home Edition, or Tablet PC with Service Pack 2;
Windows 2000 with Service Pack 4, Windows Server 2003

e 128MB of RAM (256MB or higher recommended)
e 335MB of available hard disk space

e Microsoft Internet Explorer 8.0

IMPORTANT NOTE: The system has been tested to work with Acrobat version 7.1.3 (or later). If
both Reader and Acrobat are installed on the same computer, it is recommended for best
performance that both are the same version.

Although Adobe Corporation advertises that their Reader product works on other operating systems
(see list below), Aviation Safety does not have the resources to support these multiple platforms.

Windows Platforms (Not supported by Aviation Safety)

Microsoft Vista

Microsoft Windows 7

Firefox v2 or v3

Google Chrome

Apple Safari
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Macintosh

Adobe Reader v9.1.1

Adobe Flash Player v10.0.22.87 (or later)
PowerPC G4, G5, or Intel processor

Mac OS X v10.4.11 to 10.5.6

128MB of RAM (256MB or higher recommended)
405MB of available hard disk space

Safari 2.0.4 (or later)

Linux

Adobe Reader v9.1.1

Adobe Flash Player v10.0.22.87 (or later)

32-bit Intel Pentium processor or equivalent

Red Hat Linux WS 5, SUSE Linux Enterprise Desktop (SLED) 10 SP2 and Ubuntu 7.10
GNOME or KDE Desktop Environment

512MB of RAM (1GB recommended)

150MB of available hard-disk space (additional 75MB required for all supported font packs)
GTK+ (GIMP Toolkit) user interface library, version 2.6 (or later)

Firefox 2.0 (or later)

OpenLDAP and CUPS libraries

Solaris

Adobe Reader v9.1.1

Adobe Flash Player v10.0.22.87 (or later)

32-bit Intel Pentium processor or equivalent

Solaris 10 u5 or OpenSolaris 2008.11

GNOME or KDE Desktop Environment (GNOME only for Solaris 10)

512MB or higher of available RAM (1GB recommended)

200MB of available hard-disk space (additional 75MB required for all supported font packs)
GNU C library (glibc) version 2.3 (or later)

GTK+ (GIMP Toolkit) user interface library, version 2.6 (or later) (On Solaris10, also works with
GTK 2.4.9 also)

Firefox 2.0 (or later)
Open LDAP and CUPS libraries
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3. Block or Allow Web Site Trusts

To manually allow web sites or change a web site from 'blocked' to 'allowed', follow the instructions
below.

Manually Allow Web Sites

1.

N o~

Open Adobe Acrobat Reader or click AcroRd32.exe to open Adobe Acrobat Reader and select
Run if asked to run the file.

Click Edit > Preferences on the menu bar at the top of the screen.

Select Trust Manager in the Categories list.

Click the Change Site Settings button under the Resource Access section.
Type the web address in the text box.

Click the Allow button.

Click the OK button to save and close the Preferences.

IMPORTANT: To use the eForm Service where data searches are involved, it is required to always
allow the eformservice.faa.gov web site trust.

Change Blocked Web Sites to Allowed

1.

No o~

Open Adobe Acrobat Reader or click AcroRd32.exe to open Adobe Acrobat Reader and select
Run if asked to run the file.

Click Edit > Preferences on the menu bar at the top of the screen.

Select Trust Manager in the Categories list.

Click the Change Site Settings button under the Resource Access section.

Highlight the web site in the Site listing that you want to unblock.

Click the Remaove button.

To allow the web site:

e The next time you access the web site it will ask you to Allow or Block the web site you are
entering. Click the Allow button. The web site will add itself to the Allow list in Adobe.

e If you want to manually add the web site instead of waiting till the next time you visit the
web site, follow the above set of instructions on how to manually allow web sites.

Click the OK button to save and close the Preferences.
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4.  Turn Off/On Adobe Auto Complete

Turn On Adobe Auto Complete

e Open Adobe Acrobat Reader or click AcroRd32.exe to open Adobe Acrobat Reader.
e Click Edit > Preferences on the menu bar at the top of the screen.
e Select Forms in the Categories list.

e Near bottom of the screen, under Auto-Complete, click on the drop down box and change the
settings from 'Off to 'Basic'.

¢ Click the OK button to save and close the Preferences.

Turn Off Adobe Auto Complete

e Open Adobe Acrobat Reader or click AcroRd32.exe to open Adobe Acrobat Reader.
e Click Edit > Preferences on the menu bar at the top of the screen.
e Select Forms in the Categories list.

e Near bottom of the screen, under Auto-Complete, click on the drop-down box and change the
settings from 'Basic' to 'Off".

¢ Click the OK button to save and close the Preferences.
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5. eForms

5.1 User Login/Logout

5.1.1 Login

To enter the eForm system, follow the login procedure below.

1. Access the http://eformservice.faa.gov/eForms.aspx web site.

2. Under AVS Form Manager Access on the right side of the home page, click on the Log Into
eForm Service link.

Electronic Forms
Topics

* What's New

» System
Requirements

& User Support
# Help Topics

# Tutorials

Application Web
Sites

* Form 337 Web Site

Federal Aviation
Administration

Aviation Safety eForm Service - Home

s eForm Service

The Office of Aviation Safety (AVS) provides an
electronic Farm Senice in support of the
Government PaperWWark Elimination Act (GPEA)
and eGOV initiatives  Creating and submitting
forms electronically greatly speeds up form
processing as opposed to manual paper processing
methads

« Registration

The AWV'S electronic Form Senvice user interface
{Form Manager) is a secure web-based application
and, thersfore, requires a user account and
password within the AVS domain for access
FAAIANVS employees can access the system with
thair AVS user account and use the available farms
within Form Manager based on that account’s
permissions.

In some cases, industry users may need to present
their current FAA-issued certifications. This may
require making an appointment to visit the local field
office

For more help with the eForm System, contact
AVS Mational Service Desk at: 877-287-6731
Email AVS Mational Service Desk

Log Into eForm Service

Get Adobe
Reader |
fe

Get ADOBE I
FLASH PLAYER
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3. A Warning page appears as shown below. To proceed to the eForm Service login page, click on
the 1 Agree to these terms button.

Federal Aviation
Administration

AY¥S eForm Service Home

“Warning**Warning**¥arning**

This iz a Federal Aviation Administration (FAL) protected computer system.
All FAA systems, including all related equipment, netwarks, and netwark
devices (e.g., including Internet access) are provided for the processing of

official United States (U3} Government information.

Intentionally accessing a protected Government computer without authorization
or in excess of authority and as a result causing damage, recklessly or otherwise,
will constitute a wviolation of Title 18, United States Code, Section 1030,
Computer Fraud and Abuse Act (CFAA), and may be referred to the Federal Bureau
of Investigation (FBI for investigation and prosecution. Miolations of the CRAL,
can lead to bath civil and criminal liability, including seeking monetary relief
for ecanomic darmage.

The FAA will maonitor usage for vialations of public laws, national information
security policies, and agency policy. The FAS will intercept, record, audit, read,
copy, and disclose by and to authorized personnel for official purposes,
including adrministrative, civil, and/or criminal investigations.

Access or use of this computer system by any person, whether autharized or
unautharized, constitutes consent and monitoring to these terms for violation of
Federal laws, national security policy, and agency cormputer policy. If you are nat
an authorized user of this system or do not consent to monitoring, exit this system now.

*Warning**Warning**Warning™*

I Agree to these terms
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4. The eForm Service Access page appears. Enter the username and password that you use to
access your computer and click the Login button.

Federal Aviation

Administration AVS eForm Service Home

eForm Service Access

Username: I

Password: | Use this page to log into the AVS eForm Semice using your AVS User ID and Password

FAA.gov Home | Privacy Policy | Web Policies & Notices | Site Map | Contact Us | Help

NOTE: After three attempts of entering the wrong login information, the system will log you
out. The following message appears, instructing you to close the browser, re-open it, and re-
navigate back to the Login page.

f}uagge&ﬂuhl’ﬁﬁny:agnm zain, close and re-

5.1.2 Logout

1. To log out of the eForm system, click on the Logout button on the top menu bar of the Form
Manager.

Aviation Safety
eForm Service - Form Manager

Preferences : Messages | eFormAdmin @ Help» : Logout éWelcumeBuuman.Cwlhia

2. A confirmation window will appear, as shown below. Click OK to exit the Form Manager.

Please Caonfirm

Are you sure you want to logout?
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5.2 Display Options
521 Create More Room to See the Form

To create more room to see the form, you can hide the following toolbars.

e Form Tabs Bar

¢ Document Message Bar

e Form Toolbar

—jﬁ,rm Tabs Bar _
X
Task Details Form =
ﬁ H = & [t ]2 il & ’P% | & @ [F13% - ngignv =
= | Form Toolbar |
.:|F|nd 2
| 3| rlease il ut thefolowing form,
B
[ Document Message Bar
2.4
o
=l
l [ save J l |7 Offline «# Complete
|

5.2.2 Hide/Show Form Tabs Bar

To increase the visible area of the form, click the Maximize/Minimize button & on the right side of
the Form Tabs. Click the button again to reduce the form to its previous size as necessary.

Form Tabs Bar
X
=

Task Details Form

= & e $i iz % & @@ Aoo- | [
[Find -

=] Plase flutthe olowin form.

a. N
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523 Hide/Show Form Toolbar

NOTE: Depending on the version of Adobe Acrobat or Reader you're using in your web browser,
your toolbar views and options may differ from the examples shown here.

To hide or show the Form toolbar, follow the instructions below.

Task Details Form 5
= H =1 4 W [Ttz [k &' '{% | & & [ - ;;ﬁ“ sgnv =
|Fin-:| -

(=] Please fil out the Following Form. H\
Form Toolbar ]

@ |

Hide Form Toolbar

To hide the Form Toolbar, right-click on a blank part of the toolbar and select "Hide Toolbars", or
press the F8 key on the keyboard.

NOTE: You can also right-click anywhere on the toolbar and select Show/Hide Toolbars > Hide

Toolbars.
Task Details Form =3
i ! i = =) i '. | 1 3 3y s & — A [
; E.ﬁ ﬁ % ! i Ik Ky 4 | . Analysis |—*:|
Hird 5 Carmment & Markup
b % Edit
15i Flease fill out the Following Form, v File _
v Find
v Fage Display %
v Page Mawvigation
(.‘ v Select & Zoom
US Department FAA EMPLOYEE SUG! ¥ Tasks
of Transportation —
Federal Aviation Properties Bar Chrl+E
Administration
Instructions to Suggester Reset Toolbars Alt+FE  miner
An idea for improvement is always needed. Describe your idea on this fo) IEJ ﬂida Toaolbars Fg
each idea. Fumnish all information reguested. Give the suggestion o yol j
R Tt Rl 1 LA el i e e S 1 K cL ) | U A i Ll:lc|5 Toolbars
| H Save | | 2 Offline | Button Labels P | | o« Complete
Mare Tonls, .,
I — I —

Show Form Toolbar

To display the Form Toolbar, click anywhere on the form and press the F8 key on the keyboard.
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5.2.4 Hide/Show Document Message Bar

The Document Message Bar contains instructions on how to proceed with the form and includes
special buttons associated with the task. The bar is color coded: purple for forms, yellow for reviews,
and blue for certified or secure PDFs.

To hide or show the Document Message Bar, follow the instruction below.

: @ ﬂ n_il i % IT-'I2 - Tk “_IL F[{él | & & |?1.3°."'o = _;ﬂ Sign = §

Find -

| =] Please fill out the Following Form.

|
|

Document Message Bar

J

[

Click the Forms button H on the left to hide or show the Document Message Bar. Whatever it is
set to when the form is closed is maintained the next time the form is opened.

Click the Highlight Fields button 5 to the right of the bar to highlight the sections on the form that

need to be filled out.
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5.3

Aviation Safety

eForm Service - Form Manager

Navigating Form Manager

5.3.1 Top Menu Bar

The menu bar is located at the very top of the Form Manager screen. It allows you to set your

preferences, read system messages, get eForm Service help, and log out. The Menu Bar is shown
below:

Preferences Messages eForms Admin Help+ Logout gwﬂcume Ku, Kevin

A brief description of the Top Menu Bar:

Preferences: Change your global preferences for the Form Manager. For more about setting
your preferences see the Setting My Preferences Help topic.

Messages: These are notices of events that occur during your current session. The messages
are about two types of events:

e System events, such as login and server errors
e Business process events, such as completion of a task and new tasks arriving in your
Worklist

To sort the messages in ascending or descending order, click the Description column
heading. Click Exit Messages to exit the page.

eForms Admin: This link is available only to internal AVS users who are authorized to perform
various functions pertaining to the eForm Service (i.e. reporting, user account requests, etc).

Help: This option provides a link to eForm Service Help Topics and a link that displays system
information about the AVS Form Manager.

Logout: This option logs you out of the Form Manager. When selected, a confirmation
window will appear, as shown below.

Please Confirm

Are you sure you want to logout?

UNCONTROLLED COPY
11



AVS eForm Service User Guide Revision: 5.0

Date: 10/28/2011

5.3.2 Form Directory Panel

Use the form directory panel on the left side of the Form Manager to browse for forms. This panel
(see example below) displays forms in different categories and allows for easy organization of the
forms.

NOTE: To open a form in any category, make sure to double-click on the form name instead of the
star icon next to it. Clicking the star icon adds/removes the form to/from the Favorites category.

Aviation Safety
eForm Service - Form Manager

Proferences Messages eForms Admin HE.’Ipv: Logouit Welcome Ku, Kevin

The following itermns need your attention before they can be submitted or resubmitted. Please
select a form to edit

Process |d | Process Instructions Description /. Updated Date =
Name L=

vizl Favorites

>z DOT - General (4)

b - | FAA-Flight Standards (5)
» |- FAA-General (5)

b= | OF -General (2)

= SF - General (2)

Searching for Forms

On top of the Form Directory Panel is a Search box to help you find the forms easily. Type the name
of a particular form in the Search field and a list of all forms that match the search criteria will
appear. As you type a character, any form that has that character in its name will appear until the
search parameter is narrowed to the form you want.

Related Topics:

Setting Favorites

Searching for a Form
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5.3.3 Form Manager Tabs

The Form Manager Tabs consist of the Worklist tab, In Progress tab, and Archived tab. These
tabs help organize the forms in the workflow.

To view or process a form, position the mouse pointer over the task, which will also highlight it, and
double-click to open the form. You can have only one form open at a time. Placing the mouse
pointer over the task will also display a box containing information about that task.

To view the list in ascending or descending order, click on the corresponding column heading (such
as by Process ID, Process Name, etc.) to rearrange the view as desired.

Aviation Safety
eForm Service - Form Manager

Preferences Messages eForms Admin Help~ | Logout Welcome Lerlop, Mick

Q

vE Favorites

»|=| DOT-General (2)

The following items need your attention before they can be submitted or resubmitted. Please selecta
form to edit.

Process|d | Process Name | Instructions Description #| Updated Date v

»|=| FAA-Flight Standards (6) B o Agricultural Thisisthe  05/14/2009 14559 i =
»|=| FAA-General (2) Afrcraft electronic P
Operator form for
»|=| OF -General (2) Certificate "Agricultural
» =) SF-General (2) Application Aircraft
Operator
Process Id: 0
Task id: 858
Task Status: Draft from created task
Step Name: Agricultural Aircraft Operator Certificate
Application
Air Carrier STHE
Aircraft / electronic AN
Engine form for "Air
Utilization Carrier Aircraft
Report / Engine

I

Worklist Tab

The Worklist tab (as shown in example above) lists active forms that need to be processed for either
approval or rejection (if submitted to you as part of a workflow, i.e. the Form 337) or forms saved as
draft and awaiting future editing. See the "Worklist Overview" Help topic for more details.

In Progress Tab

The In Progress tab lists the workflow forms that have an automated business process (i.e. the
Form 337) and are currently in progress and waiting for review, approval, rejection, etc. These forms
are read-only. See the "In Progress Overview" Help topic for more details.

Archived Tab

The Archived Tab lists the completed Workflow forms that you submitted online. These are read-
only copies of the form and cannot be edited. EForms without a workflow and are not associated
with a tracking number may be edited when you create a new instance of the form. See the
"Archived Overview" and "Create a New Form" Help topics for more details.

UNCONTROLLED COPY
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534 Form Tabs Bar

The Form Tabs Bar for most electronic forms consists of Task Details and Form. The
Attachments tab is not available on all forms; this tab will appear only on forms that allow the
attachment of files or notes with the form submission.

NOTE: Forms that allow the user to forward a task to someone else will also display a Forwarding
tab on the Form Tabs Bar.

Form Tabs Bar

Task Details Form Attachments (0) &=
BAD %[ WY € o= Aso- [EF
;lFind -

5| Plesse il th Follning orm.

=

[ &N |
Task Details

The Task Details tab displays general information about the type of task and specific information
about the current task and process.

On the bottom of the tab window are icons that allow you to lock/unlock the task, abandon and
remove the task, or forward the task (if applicable) to another user.

Major Repair/Alteration

Task Details Form Attachments (0)

Major Repair/Alteration

Instructions

Description

Deadline Date

Creation Date

Updated Date

Task Id

Status

Process Details

= iption
Lock this task to prevent others from claiming it ]

El:;mard this task to another user

(&) (] (=

Date

Process Name

Abandon and remowve this task

Fill out this form to get your repair approved.

Electronic Form for "Major Repair/Alteration” (Form 337)

Oct 22,2009 - B:44:33
Mow 03, 2009 - 14:42:36
11285

Draftfrom created task
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Form
The form is displayed in .pdf format and process buttons are provided on the bottom of the window.

| Save
The Save to Worklist (Draft) button M on the lower-left corner allows you to save the form

and complete it at a later time. See the "Saving to Worklist (Draft)" Help topic for more details.

|=), Offline
The Take this Form Offline button [L“—J allows you to save a copy of the form on your
computer or an external device.

Major Repair/Alteration X

Task Details Form Attachments (0) =

BB eef: MO g e[ L+ [d
'IFind—'

Faim Approeied Elacironic Trockisg Mumbe:
e OME N2 21200020
i MAJOR REPAIR AND ALTERATION JaRa o FAR Ui BTy
AT ooninton {Airframe, Powerplant, Propeller, or Appliance)
Adivin i stiation

INSTRIUCTIONS: Print or type all entries. See Title 14 CFR §43.9. Part 43 Appendix B, and AC 43.2-1 [or subsequent revision thereof) for
instructions and disposifion of this form. This report is required by law (40 U.5.C. §H701). Failure to report can result in a civil penaity for each
such violation. (48 U.S.C. §46301(a))

janthegrwumnMa:‘ { ISE'HND.
1. Rircrait |M.a.he Wiodel Tere=
k|
lﬂ‘SaueIll_,,.Ofﬂmel q{?Corrpletel

UNCONTROLLED COPY

15



AVS eForm Service User Guide Revision: 5.0

Date: 10/28/2011

Attachments

You can add notes and file attachments to a form if the process allows it. Other users who
participate in the process can view, update, and delete the notes or attachments if you provide
permission. For more details, see the Help Topic for specific forms that have this feature.

Major Repair/Alteration

Task Details Form Attachments (0)

Add New ) Attachment | | Note
L L

Mame

Permissions | Read Only

Type I Send to Registry

There are no ftems to display.

5.3.5 Form Navigation Panel

The Form Navigation Panel adds more functionality to the Workflow Forms. To show or hide the
Navigation Panel, right-click on the left side of the window and select “Show Navigation Panel
Buttons” or “Hide Navigation Panel Buttons”. By default, only a selected set of panel buttons
appears on the left side of the work area. Click the buttons to show or hide the views.

1 FAA REGIS | HY
v & sglect Tool 7
4% Hand Tool R —
% Marguee Zoom | 4 tttachments
Rotate Clockwise Shift+Ctrl+Plus [ L~ Comments Il
=l Brint... Crl4P E ':'Eg Model Tree !
39 search Shift+Ctrl+F [l Pages

, E# sSignatures
Document Properties...

Fage Display Preferences... Reset Panels

B

Show Mavigation Parel Buttons Hide Navigation Panel Buttons
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NOTE: Depending on the version of Adobe Acrobat or Reader you're using in your web browser,
the panel buttons in the navigation panel may differ from the examples shown here.

e Forms
e Info

e Pages
e Search

e Signatures
e Comments

e Attachments

An example of the Navigation Panel is shown below:

B8 8- iz kY & | ®

-<:1J Pages

1 Signatures

<:.IJ Comments

Fy—
< ';l.l Attachments

5.35.1 Forms

The Forms button i%l shows the Document Message Bar, which contains instructions on
how to proceed with the form and includes special buttons associated with the task. The bar
is color coded: purple for forms, yellow for reviews, and blue for certified or secure PDFs
(such as when a signature is present). Click on the Highlight Fields button to the right of
the bar to highlight form fields.

5.35.2 Info

The Info button displays information about the document extensions. It allows the user to
view extended usage rights and displays other information about the document that's
currently open.
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NOTE: This icon appears only for users who use Adobe Reader in their Internet browser.

Document Extensions

You have extended Rights ko save,
submit, and comment on the POF,

This document contains inkerackive
Form fields.

You can save data kyped into this
Form.

%ou can digitally sign this document,

5.3.5.3 Pages

The Pages button displays the Page thumbnails, which are miniature previews of the pages

in a document. Click on the thumbnail to jump quickly to a specific page.

UNCONTROLLED COPY

18



AVS eForm Service User Guide

Revision: 5.0

Date: 10/28/2011

5.35.4 Search

The Search button displays a panel that allows the user to run searches to find a specific

word or phrase in the document.

What word or phrase would wou
like bo search For?

[T whole words only

[T Case-Sensitive

[T Include Bookmarks

[ Include Comments

Seafch |

Ise Advanced Search Options

Find a word in the current

5.3.5.5 Signatures

The Signature button displays a panel with information about each signature in the
document. Information is displayed only for documents that contain a digital signature. Each
signature will have an icon identifying its verification status and can be viewed by expanding
the signature. The Signatures panel also provides information about the time the document

was signed and other signature details.

Signatures

- Yalidate Al

= %} Rev. 1: Signed by John A. Smith <j
Signakture is walid:
Docurment has not been modified 3
Signed by the current user
Signature dateftime are from the g

Signature Details
Last Checked: 2009.11.05 13:5%:33
Field: SignatureFisldl on page 1

Click to wiew this version
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5.3.5.6 Comments

Ignore the Comments button in the navigation panel. This has been disabled for the current
version of the system.

‘m r ‘ Expand All ‘ Callapse All Mexk Previous | - Show + I; : Sork By - i ;’ Search

This document has no comments,

5.3.5.7 Attachments

Ignore the Attachment button or paperclip icon in the navigation panel. This has been
disabled for the current version of the system.

W7 search

Description Modified
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5.4 Form Manager Tools

54.1 Overview

The LiveCycle Form Manager enables the use of the web browser to find, organize, and process
eforms. Use LiveCycle Form Manager to perform the following tasks:

e Open and fill out forms in the web browser
¢ Find forms quickly and easily
¢ Reuse forms that were previously completed

e Customize the presentation of forms

With LiveCycle Form Manager (see example below), the user can also initiate online routing and
automated processing of .pdf forms within the user's organization.

Aviation Safety

Preferences essages | eForms Admin I-I:':r|:»v§ Logout Welcome Ku, Kevin
eForm Service - Form Manager :

FORMS

Q

The following iterms need your attention before they can be submitted or resubmitted. Please

7 select a form to edit.
v [=] Favorites

Process|d | Process Instructions Description . Updated Date -
Name 1i m 3

»|=| DOT-General {2)
» [=| FAA-Flight Standards (6)

B0 FAA FAA3450-17 | 11/16/200008:32 [«
» =/ FAA-General (2) Employee titled "FASA | AM |
- OF. Suggestion Employee
> |=| OF -General (2) St
»S] 5F-General (2) B 0 Bird / Other Thisisthe 091720091000 [ =
Wildlife Strike electronic Al
Report form for
"Bird / Other
wildlife Strike b
Report". The
FAA farm
number is
5200-7.

5.4.2  Setting Preferences

Preferences allows customization of the Form Manager for personal viewing. This feature is divided
into two categories:

e Manage Out of Office

e Manage Worklists
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5.4.2.1 Manage Out of Office

Set preferences to control how your tasks are assigned to other people while you are out of
the office. In your absence, you allow others to process or complete forms on your behalf
(i.e. approve or reject for the Form 337 process). You can also specify exceptions for tasks
from specific processes to be sent to another user or remain in your worklist until you return.

Aviation Safety
eForm Service - Form Manager

Preferances E55A0Es eForms Admin Help Logout Welcome Ku, Kevin

48 MANAGE OUT OF OFFICE

4& lam currantly: | Inthe Office 'J

Out of Office Schedule

Add Date Range

When Out of the Office

Default User for Out of Office tasks T

Process Exceptions

Add an Exception

Exit Preferences

To specify when you are out of the office, do one of the following options:

e If you are out of the office for an indefinite time period, select Out of the Office but do not add a
date range

e To specify a start date and time that you will be out of the office, select Out of the Office and
click Add Date Range

To specify how your tasks will be handled by default, select one of the following options:
e Select Do not assign to keep tasks in your worklist until you return

e Select Find User to search for a user to assign your tasks to. When you select a user, you can
also view their out-of-office schedule

To set exceptions to the default, click Add an Exception and select a specific form to assign to a
specific user as necessary.

Click Save when you've finished setting your preferences.

Click Exit Preferences on the bottom right corner of the tab window when finished.
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5.4.2.2 Manage Worklists

Share my worklists

Selecting Share my worklists allows you to provide any number of people with access to
your worklist.

NOTE: Only new draft forms or new assigned tasks (i.e. Form 337) can be viewed in a
Worklist AFTER an Out of Office or Manage Worklist preference setting has been
established.

NOTE: Due to privacy issues, Human Resource/Personnel type forms cannot be shared.

The form disappears from your worklist when the user to whom you have given access
opens the form. That user becomes the owner of the form until it is forwarded to another
user.

Aviation Safety
eForm Service - Form Manager

Preferences Messages eForms Admin Hll||:'v§ Logout Welcome Ku, Kevin

a MANAGE WORKLISTS

(w) Sharemy worklist | () Access anotherworklist
L b=

l Find I Users currently sharing my worklist:

Mame

Share with:

Exit Preferences

To share your worklist, do the following:

1. Select Share my worklist.

2. Type the name or partial name of the user in the Name text box.
NOTE: You can enter either the first name or the last name (not both) or the format of
(lastname, firstname). User name is not case-sensitive.

3. Click Find to list all of the user names that match the search criteria.
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4. Select the name of the user and click Share or double-click the user name. A list of
users who are currently sharing your worklist will appear on the right side of the page.

5. To delete the name of users from the list, select the name from the User Currently
Sharing My Worklist window and click Remove on the bottom right of the list
window.

Access another worklist

Selecting Access another worklist allows you to submit a request to access another
worklist and displays a list of worklists in which you have access.

Aviation Safety
eForm Service - Form Manager

Preferances | ssages | eFormsAdmin | Help~ | Logou Welcome Ku, Kevin

‘ MANAGE WORKLISTS

& Share ry worklist ] Access another worklist

i Users worklists that | have access to:

Email MName

Access tor Reguest *-denotes request is pending

Exit Preferences

To access another worklist, do the following:

1. Select Access another worklist.

2. Type the name or partial name of the user in the Name text box whose worklist you
want to access.

NOTE: You can enter either the first name or the last name (not both) or the format of
(lastname, firstname). User name is not case-sensitive.

Click Find to list all user names that match the search criteria.

4. Select the name of the user and click Request. A list of users whose worklist you will
have access to will appear on the right side of the page.
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5. To remove your access to another worklist, select the user name from the Users
Worklist That | have Access To list and click Remove on the bottom right of the list
window.

NOTE: You cannot remove your access to another worklist when the request to access the
worklist is still pending.

5.5 Form Categories

5.5.1 Setting Favorites

The Favorites category (see example below) is in the Form Directory Panel, located on the left side
of the Form Manager window.

By setting favorites, you can group all the forms that are used frequently into a single category so
that you can find them quickly.

FORMS

qQ
v || Favorites (1) <fmmm

i FAMEmployee Suggestion
= DOT - General [4)
» | FAA-Flight Standards (5)
v | FAA-General (5)
¢ FAA Employee Suggestion

ﬁfi' Publicationis) Request
<" Military Status Report

1]‘_:‘? Recard of Visit / Conference /ar 1

{? Request for Promotion Consideri
> -| OF -General (2}
» || 5F-General (2)

5.5.1.1 Adding and Removing Forms in the Favorites Category

1. Select the category that contains the form.

2. Click the hollow star icon k¢ next to the form name. The form is added to your
Favorites category, and a solid star “* appears next to the form to indicate that the
form is a favorite.

3. To remove a form from the Favorites category, click the star again. The form appears in
its original category with a hollow star next to the name.

NOTE: Be sure to click on the star icon; accidentally double-clicking on the form name will
open the form.
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55.2 Worklist

55.2.1 Worklist Overview

The Worklist tab displays a list of active forms that are still in process. It could include
forms that are sent to you as part of an automated workflow and need to be processed for
approval or rejection (i.e. a Form 337), or forms that were saved for future editing or
completion.

NOTE: To view the list in ascending or descending order (such as by Process ID, Process
Name, etc.), click on the corresponding column heading to rearrange the view as desired.

WORKLIST

The following iterms need your attention befora they can be submitted or resubmitted. Please
select a form to edit.

Process Id | Process Instructions Description . Updated Date &
Mame . L

[ 850 fajor Ku, Kevin subrmitted a 08/12/2008 15:15 [:;
% Repair/flterat Form 337 foryour P

Process [d: 850

TaskId: 1026
g 5! Task Status: Draft from assigned task

Step Name: Waiting RTS Approval

Initiator: Ku, Kevin

Process Start Date: 07/24/2008 10:08 AWM
B o E out thisTorm o Form 337 07/24/2008 10:06 <4 [
Fepair/Alterat  getyour repair A

ion approved.

OB/ OR/2008 14:31 :{,'i'
P

Open a Form in the Worklist Tab

To view or process a form, position the mouse pointer over a task, which will also highlight
it, and double-click to open the form. Placing the mouse pointer over the task will also
display a box containing information about that task. A .pdf copy of the form will open in the
same window. You can have only one form open at a time.

Forward a Form in the Worklist Tab

If the process allows it, you can choose to forward a form to another user by clicking on the
Forward icon %% . Refer to Forwarding a Task for further details.
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5.5.2.2 Worklist Columns

The Worklist page displays all forms that require some action and consists of columns that
show the process ID, name, instructions for the task, form/task description, and date the
form was last updated.

The following items need your attention before they can be submitted or resubmitted.
Please select a form to edit

Process | Process Instructions | Description | Updated
d | Name Date

Process ID: Unique technical (system) ID number that identifies each form upon execution
of a process. It is "0" (zero) until the first time the Complete button is clicked in the form user
interface.

Process Name: Name of the form or process.
Instructions: Any instructions needed to process the form.
Description: Description of the form/workflow process.
Updated Date: The date the process was last updated.
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5.5.2.3 Change Task Description in Worklist
The description for each form or task can be changed (or added) while in Worklist view.

NOTE: This description is used for organizing your own Worklist and does not go with the
task when it is sent to the next stage of the process. The only exception is when the task is
forwarded to another user since the description stays only with forwarded tasks.

Refer to Changing Task Description in Worklist View Help Topic in the Working with the
Form category to change the description for a form or task in the Worklist view.

55.2.4 Forward a Task

While in the Wc_)_rklist tab, you can forward a form or task to another user by clicking on the
Forward icon 5% (see example below). Refer to Forwarding a Task for further details.

The following items need your attention before they can be submitted or resubmitted. Please
select a form to edit

Process|d | Process Instructions Description /| Updat
Mame +| e ed b
853 Major Lerlop, Mick U?124,’1
Repair/Alterat submitted a Form B11:49
ion 337 foryour Al
approval. (Tracking#:

200B000057)

Majar Fill out thisform to | Form 337 07/24/200 :5 i
Repair/Alterat getyour repair 8 09:33
ion approved. Al

Related Topics:

Forwarding a Task
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5.5.2.5 Delete a Draft Form
NOTE: Only the author of the form can delete a draft form.

A form that was saved to Draft will appear on the Worklist with a H icon to the left of the
form (see example below). To delete the draft form, simply click on the trash icon to the right
of the form. Note that this action cannot be undone.

The following items need your attention before they can be submitted or resubmitted. Please

select aform to edit

Process Id | Process
Mame

[jﬂ F A

Employee

.! Suggestion

Eo Agricultural
Aircraft
Operator
Certificate
Application

Instructions Dacri?tion /| Updated Date e
] i | *

Thisis the 08/26/2009 10:07
electronic Al

form for

"FAA

Employee

Suggestion”.

The FAA form

is 3450-17.

Thisis the 0B/20/2009 14:50
electronic =

form for

"Agricultural

Aircraft

@

S

After clicking the trash icon, a confirmation box appears, as shown below. Click OK when
ready or Cancel to return to the Worklist.

Are you sure you want to delete this entire process?

This cannot be undone.
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5.5.3

5.53.1

In Progress

In Progress Overview

The In Progress tab lists forms that are in progress but not yet finalized. Each item can be
identified by the unique Process ID. Double-clicking on any of the items on the list will
display two tabs: Process Details and Audit

NOTE: Users can view the Audit (History) under the In Progress tab for forms that have an
automated business process (i.e. for Form 337).

To view the list in ascending or descending order (such as by Process ID, Tracking No.,
etc.), click on the corresponding column heading to rearrange the view as desired.

IN PROGRESS

The following iterms are READ OMLY copies of PDF forms that are in progress. Gao ta My
Worklist to edit forms.

Process |D & | Tracking | Proces | Step Mame

B38
839
B40
E41
B42
B43
B44

337
37
337
337
337
37
337
2008000 | 337
2008000 | 337
2008000 | 337

Assign to
Assign to

337 Compaonent
Assign to
Assign to
Assign to
Assign to
Waiting RTS
Waiting RTS
Waiting RTS

. Assigned To

Lerlop, Mick
Lerlop, Mick
Lerlop, Mick
Lerlop, Mick
Lerlop, Mick
Lerlop, Mick
Lerlop, Mick
Lerlop, Mick
Lerlop, Mick
Ku, Kevin
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. 07/23/2008 21:38 PM

. Updated Date

077232008 21:44 PM
07/23/2008 21:48 PM
07/23/2008 21:51 PM
07/23/2008 22:03 PM
077232008 22:07 PM
07/23/2008 22:11 PM

08/12/2008 15:15 PM
08/08/2008 14:31 PM
08/06/2008 13:47 PM
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Process Details

On the Process Details tab, you can view basic details about the process instance, including
its creation date, status, and other information regarding the task.

Process Details

Description

Creation Date

Updated Date

Process Name

Process Id

Process Status

Process Variables
trackingMumber
Current Pending Tasks
User

Mechanic2

The Office of Aviation Safety (AVS) provides an electronic
Form Service in support of the Government PaperWork
Elimination Act (GPEA) and eGOV initiatives. Creating
and submitting forms electronically greatly speeds up
form processing as opposed to manual paper processing
methods. The electronic FaA Form 337, which is available
from this site, provides for the creation, submission and
approval of the FAS Major Repair and Alterationinan
effort to save time and effort in service to Industry
customers and to promaote Aviation Safety.

Aug 27, 2008 - 9:19:22
Aug 27, 2008 - 9:27:38
337

1802

Running

2008001178

Instructions

Mechanicl submitted a Form 337 for your approval.
(Tracking#: 200B0071178)
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Audit

On the Audit tab, you can view the tasks that are part of the process instance and the
associated form, assignments, and attachments for each task.

Process Details Audit
Select a Task to view the assignments, notes and attachments, and form data associated with it

+, Tashs for Process Instance 1802
it

Task Id Instructions Selected Route Creation Date Completion Date

Mechanicl submitted a Aug 27, 2008 - 9:19:30
Form 337 foryour

approval. (Tracking#:

200B001178)

Fill out this form to get Aug 27, 2008 - 9:08:12 Aug 27, 2008 - 9:19:18
your repair approved.

{%j Motes and Attachments for Task
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554 Archived

5541 Archived Overview

The Archived tab displays a list of forms that have been submitted online and workflow
forms that were approved by all channels. You can view the Audit (History) for all completed
forms under the Archived tab. These forms are all read-only. Archived copies are retained
for 365 days. By default, the page displays forms processed for the last 60 days, but you

may click on the calendar icon i 1o perform a search as early as 365 days from the current
date.

An example of the Archived tab is shown below. Double-clicking on any of the items on the
list will display two tabs: Process Details and Audit

Any eForm that has just been completed will appear under Archived. Hit the F5 key to
refresh the page as necessary. A Form 337 will appear under Archived only after it has
been approved.

NOTE: To view the list in ascending or descending order (such as by Process ID, Task ID,
etc.), click on the corresponding column heading to rearrange the view as desired.

ARCHIVED

The following items are READ ONLY copies of completed POF forms and are viewable here for up to
365 days.

From | og/01/2000 [ To | 11/16/2009 [

Process 1D Tracking Mumber | Process Mame 4 [| v | Complete Date  w
2420 Fas Employes Suggestion 0B/21/2009 10:27 AM
2419 FAM Employee Suggestion 0B/20/2008 14:45 PM
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Process Details

On the Process Details tab, you can view basic details about the process instance, including
its creation date, status, and other information regarding the task.

Process Details Audit

Process Details
Description
Creation Date
Complete Date
Process Mame
Process Id
Process Status

Process Variables

Electronic Form for "FA& Employee Suggestion”. FAA Form # 3450-17.

Aug 21, 2009 -10:27:40
Aug 21, 2009 -10:27:40
FAM Employee Suggestion
2420

Complete
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Audit

On the Audit tab, you can view the tasks that are part of the process instance and the
associated form, assignments, and attachments (if allowed by process) for each task.

Process Details Auclit
Select a Task to view the assignments, notes and attachrnents, and form data associated with it

w, Tasks for Process Instance 2420
| _.ﬁ

Task Id Instructions Selected Route Creation Date

= S 25936 Aug 21, 2009 - 10:22:36

Completion Date
Aug 27, 2006 - 9:10:28

4133 Mates and Attachments for Task
|

| % Assignments for Task

I%r Form for Task
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55.4.2 View Archived Form

To view a completed form in the Archived category, go to the Audit tab and click on the View

Form icon & to open the form. Note that the form is read-only. You can also view the
Assignments and the Notes and Attachments (if allowed by process) for each completed
task by clicking and expanding the related icons in the Audit tab. See example below.

_@: Tasks for Process Instance 50202

| Taskld | Instructions | Selected Route | Creation Date | Completion Date

MNow 20, 2008 - B:39:06 Mo 20, 2008 - 8:42:3R
submission was
approved by
Eowman,
Cynthia.(Tracking#:
2008001559
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55.4.3 View Audit Trail

To view the audit trail for a completed form, click on a form in the Archived category and go
to the Audit tab to see the workflow history. See example below.

Process Details Audit
| Salected Task 31001

_'.31 Tasks for Process Instance 50202

Task Id Instructions Selected Route | Creation Date Completion Date

é:_) a S 31001 Mechanicl submitted Moy 20, 2008 - B:43:49 Moy 20, 2008 - B:46:27
- aForm 337 for your
approval. (Trackingd#:
2008001559)
\%‘_‘J & Your Form 337 Mow 20, 2008 - B:39:06 Nov 20, 2008 - B:42:38
submission was
approved by
Bowrman,
Cynthia.(Tracking#:
2008001559
- 3 S A1 Mechanic] submitted  Annrove M 16, 2008 - M 200 3008 - 3638

cf‘vj Attachments (1)

% Assignments for Task 31001

Iﬁ" Form for Task 31001

[
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5.5.4.4 Change Task Description in Archived

The description for each form or task can also be changed (or added) while in the Archived
view, as well as the Worklist view.

NOTE: This description is used for organizing your Archived views and does not go with the
task when it is sent to the next stage of the workflow process. The only exception is when
the task is forwarded to another user since the description stays only with forwarded tasks.

Refer to Changing Task Description in Archived View Help Topic in the Working with the

Form category to change the description for a form or task in the Archived view.

55.4.5 Create a New Form

In the Archived category, a new instance of the form can be created from an existing form

=
el

by clicking the New Form icon * ! on the bottom left corner of the page. Data entries in
the existing form may be retained as needed and all fields are editable.

NOTE: This function is not available for archived forms that were processed using a
workflow, such as the Form 337, due to unique tracking numbers associated with the forms.

Process Details Auclit
Selected Task 2936

cv Tasks for Process Instance 2420

85
.% Assignments for Task 2036

5- Form for Task 2936

== JESEETE O

Ik

O K e e [ (G :

R

US Depanment
of Transportation
Federal Aviation

T K il

Start a new process with this Task data.

FAA EMPLOYEE SUGGESTION
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5.6

Working with the Form

5.6.1 Form Manager Icons

The Adobe LiveCycle Form Manager will display several different icons that act as buttons to aid in
the processing of the eForms. The definitions below will help you recognize the difference between
each of the icons used in the eForm Workflow process. The use of these icons is also covered in
various Help Topics that include more information about their function in the workflow.

‘@ Attachment - Save: This icon of a paperclip with blue down arrow is found under the
Attachments tab. Click on this icon to save a file attachment to your computer or an external device.
Some electronic forms may not have the Attachment feature.

? Attachment - Update: This icon of a paperclip with a blue up arrow is found under the
Attachments tab. Click on this icon to upload an updated file attachment to the form. Some
electronic forms may not have the Attachment feature.

& Audit - View Assignments: This icon is found in the Audit view of a task under the In
Progress tab and the Archived tab. Click on this icon to view the assignments for the task.

:‘-‘J. .
I Audit - View Attachments: This icon is found in the Audit view of a task under the In
Progress tab and the Archived tab. Click on this icon to view the attachments for the task.

&’F Audit - View Form: This icon is found in the Audit view of a task under the In Progress tab
and the Archived tab. Click on this icon to view the form for the task.

n

# Claim task and make it your own: This icon of an open lock is found under the Task Details
tab of a shared task. Click on this icon to claim the task and add it to your own Worklist for future
work.

% Claim and open task: This icon of an open lock with a blue right arrow is found under the
Task Details tab of a shared task. Click on this icon to claim and open the task for immediate
attention.

o Delete: This trash can icon is found in the Worklist view and the Attachments tab. Click on this
icon to delete a task or attachment. Only the initiator of the form or the attachment can perform this
function.
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-
Edit: This pencil icon is found in the Worklist view and in the Audit view of a task under the

Archived tab to allow change of the task description.

ﬁ Favorites - Add: This hollow star is found in the Directory Panel. Click on this icon to add a
form in the Favorites category.

Favorites - Remove: This solid star icon is found in the Directory Panel. Click on this icon to
remove a form from the Favorites category.

e Forwarding: This icon is found in the Worklist view and Task Details tab. Click on this icon to
forward a task to another user. In the Forwarding tab, this icon (with green arrow) appears next to
the name of the user who will receive the forwarded task.

= 3
B8 | ock: This lock icon is found under the Task Details tab. Click on this icon to lock the task and
prevent others from claiming it.

I‘—'] Remove Task: This icon is found under the Task Details tab. Click on this icon to abandon
the task and remove it from the Worklist view.

|i| Return Task: This icon is found under the Task Details tab and appears for a form that had
been forwarded to you. Click on this icon to return the task to the previous user.

ﬂ Save to Worklist (Draft): This icon is found under the Form tab to allow saving of a draft copy
of the form for future editing. The same icon will also appear next to the form on the Worklist view,
identifying that form/task as a saved draft.

)

B2 Share(d) Task: In the Worklist view, this icon represents a shared task. In the Task Details tab,
click this icon to share the task with another user.

=¥ Take Form Offline: This icon is found under the Form tab. Click on this icon to save a copy of
the form on the computer or an external device.
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5.6.2 Searching for a Form

On top of the Form Directory Panel is a Search box to help you find the forms easily. Type the name
of a particular form in the Search field and a list of all forms that match the search criteria will

appear. As you type a character, any form that has that character in its name will appear until the
search parameter is narrowed to the form you want. Click the "x" button to the right of the box to exit

the search.

Aviation Safety
eForm Service - Form Manager

vi=E Favorites

» |- DOT-General (2)

» |=| FAA-Flight Standards (9)
> =] FAA - General (7)

k= OF - General (2)

> |- 5F-General (2)
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5.6.3

Opening a Form

You can open a new form from the Form directory Panel on the left side of the window or an existing
form from any of the Form Manager tabs on the right side of the window. See example of Form

Manager below.

FORMS

Q

v - Favorites (1)
iy FAMEmployee Suggestion
» =) DOT- General (4)
*= FAA - Flight Standards (5)
v =| FAA-General (5)
¢ FAAEmployee Suggestian
T:-LI' Publication(s) Request

{}[— Military Status Report

t;:? Record of Visit / Canference far 1

f}‘- Request for Promaotion Consider:
» || OF -General (2}
> = SF - General (2]

WORKLIST

The following iterms need your attention before they can be submitted or resubmitted. Please
select aform to edit

Process |d | Process

B o

B o

Instructions
Name

iy
Employes
suggestion

Processid: 0

Taskld: 2945
Task Status: Drait from created tosk
Step Name: FAA Employee Suggestion

1 |
Operator
Certificate
Application

Opening a New Form

Description , Updated Date
- :n_ ¥
LJ 1] *

Thisis the
elactronic AR

form for

"FAM

Employee |
Suggestion”.

The FAA form |

15 3450-17.

- Ll
This is the OB/20/200% 14:50 &m’
dectronic P
form for
"Agricultural
Mircraft
Operator
Certificate
Application”.
The FAA forrm
numberis

08/26/2009 1007 G = |

B710-3. E.

In the Directory Panel on the left side of the window, open a new form in any category by
double-clicking on the form name rather than the star icon next to it. Clicking the star icon
adds/removes the form to/from the Favorites category.

Opening an Existing Form
Position the mouse pointer on an existing form to highlight it and double-click to open it.

NOTE: Placing the mouse pointer over a task will also display a black box with detailed
information about the task (see example above).
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5.6.4 Completing a Form

To complete a form, you can display the Document Message Bar and highlight the form fields.

1. Click on the forms button I%I on the left navigation pane to display the Document Message Bar.

2. Click the Highlight Fields button Ei on the right of the message bar to highlight the form
fields.

3. To fill out the form, place the mouse cursor in each field or use the tab key to advance to the
next field as necessary. When ready, click the Complete button on the right bottom corner of
the window. The completed form will be saved to the Archived system.

FAA Employee Suggestion

Task Details Form

=58 = Bz k| &Y ® ©&® EETRS W .-t
| EE

=] Plesse il ot the Follwing orm.

3
[ Document Message Bar J

Q@

US Department FAA EMPLOYEE SUGGESTION
of Transportation

Federal Aviation

Administration

Instructions to Suggester Suggestion Nurmber

An idea for improvemeant is always needed. Describe your idea on this form. Use a separats form for
each idea. Furnish all information requested. Give the suggestion to your immediate supervisor. (If

-
P B e Syt AP S | P Sy [ [t N et o __I

I.E{s“e | | [z, offline | «F Complete I

4. To exit the form, click the X button on the top right corner of the page to exit the form view.

5. A dialog box appears to confirm whether or not you want to close the form and alerts you to
save any changes made. Click OK when ready.

Are you sure you want to leave this form? You may

have unsaved changes.
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6. The completed form will appear under the Archived tab. Hit F5 key to refresh the screen as

necessary.

FORMS

Q

=l Favorites

» |- || DOT-General (4)

b || FAA-Flight Standards (&)
b |- FAA-General (5)

»|=| OF -General (2)

|| 5F-General (2)

ARCHIVED

The following items are READ ONLY copies of completed PDF forms and are viewable here for
up to 365 days.

From 06/21/2000 [ To | 082072009 3

Process ID Tracki | Process Name Descrip Complete Date

ng | e
Nurnb |
- w JE l.
( 2419 | FAA Employee Suggestion | 0B/2072009 14:45 PM )
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5.6.5 Saving a Form Offline

To save the form to the hard drive or external device, click on the 'Take this form offline' button (as
shown below). This takes the form outside of the user interface.

IMPORTANT: Copies of forms saved Offline cannot be uploaded (saved) back to the Form
Manager Worklist.

FAA Employee Suggestion X
Task Details Form =
= = NENE & [Tz il & & &8 [713% » fSign- ™ AN
|Find -
US Department FAA EMPLOYEE SUGGESTION
of Transportation
Federal Aviation
Administration
Ins Suggestion Numiber
An id Take thls form Omlne your idea on this form. Use a separate farm for
=ach i mISh &l infommation requestsd. Give the suggestion to your immediate supervisor. (IF LI
lﬂSﬂmJlLﬁ,OfﬂmeJ w# Complete
]

The 'Save a Copy' box appears to allow you to save the form as a .pdf file only. Choose the location
to save the file, type in a file name, and click the Save button.
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Save in; |@Desktup j % .'ﬁ" L

My Documents
y My Computer
Ly Metwork Places

File name: Sample Form. pdf j Save I
Save as hupe; Adobe POF Files [F. Cancel |
&

Related Topic:
Saving a Form to PDF
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5.6.6 Saving a Form to PDF

To save the form in .pdf format, click the Save icon on the tool bar above the form. In the Save
a Copy dialog box, rename the file as necessary and save to a preferred file location.

FEERY D LT = e L e
= B
» I |

Save a Copy... H x

-‘ Desktop j 0 -? -

BMy Documents
5} My Computer
HM&.-' Metwork Places
My Documents
o B
-
iy Computer
-
File narme: |-23E?5885429938??2ES-1 55, pdf Save

LefLed

[ s |
Cancel |

Save az lupe; |.-’-'u:|u:.|:|e PDF Files [*.pdf)

Related Topic:

Saving a Form Offline
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5.6.7

Saving to Worklist (Draft)

If you need to save the form for future editing or completion, you can save a draft copy of a form so
that you do not lose your existing work. This does not submit the form.

1. With the form tab open, click the Save to Worklist (Draft) button on the bottom left corner

of the form.

Major Repair/Alteration

X
TaskDetails | Form | Attachments (0) =2
SBO e WY § eoFm- L W @I -
Faim Ewctronie Trackieg Murmber j
e OME Mo 21200030
i3 _ MAJOR REPAIR AND ALTERATION et SR B
Lm:uhden {Airframe, Powerplant, Propeller, or Appliance)
Admnistiation

such violation. (49 U.5.C. §46301a))

IMSTRUCTIONS: Print or type all entries. See Title 14 CFR £43.9. Part 43 Appendix B, and AC 43.8-1 {or subsequent revision thereof) for
instructions and dispasition of thes form. This report is required by law (48 U.S.C. §44701). Failure to report can result in a civd penalty for each

Reionalty and Fegrsbabon Mark T L
: NTS04R Heiets AFSTS0
1. Aircraft (o e =
FAA REGISTRY TEST FILE AFSTSO
Tame (A shown on e Bddress [As shown on regis CerincaE]
2. Dwner x" — 5
Save to Worklist (Draft) ] s oy &
J 3. For FAA Use Only
I =
B Seve | | B Offiee | & Complete

2. A confirmation bubble briefly appears to confirm that that the form has been saved to the

Worklist view.

Preferances |

Messages

eForms Admin

Help -

'ii “ou have saved task 4347 to the Worlklist vigw,

Logout
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3.  When you exit the form and go to the Worklist view, the Save to Draft icon appears next to the
form (see example below).

The following iterms need your attention before they can be submitted or resubmitted. Please
select a form to edit.

Process |d | Process | Instructions Description / Updated Date 2
Mame ¢i N
Major Filloutthisformto | Electronic  04/30/2009 1401 57
Repair/Alterat | getyour repair Form for P
ion appraved. "Major
Repair/Alterat
ion" (Farm
337)
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5.6.8 Claiming a Shared Form

Electronic form users can claim a shared task by performing the steps below. Shared tasks have the

& icon to the left of the tasks.

1. Double-click on the shared task in the Worklist view to open it.

The following items need your attention before they can be submitted or resubmitted.
Please select a form to edit.

Process | Process Instructions Description | Updated Date =

Id Marme NIRRT

2103 i3¥ Mechanicl 09/04/2008 13:57 1;
submitted a Form P
337 foryour
approval.
(Tracking#:
2008007184)

| &£ pso2 337 Mechanict 09/04/2008 13:47 28

submitted a Form P

Shared task from group's or someone's worklist. Click for more

informatian.
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2. The Task Details window opens. Click on the left icon &J to claim the task and add it to your

own Worklist for future work. Click the right icon IEJ to claim and open the task for immediate
attention.

Major Repair/Alteration

Task Details

Major Repair/Alteration
Instructions  Fill out this form to getyour repair approved.
Description  Electronic Form for "Major Repair/Alteration” (Form 337)
Deadline Date
Creation Date  Sep (08, 2008 - 13:43:28
Updated Date  Sep 22, 2008 - 1 2:08:14
Taskld 4119
Status Draftfrom created task
Process Details

Description

eation Date

E:I'fim this task and make it your own

rrocess Name

|l (3]

Claim and open this task

Related Topic:
Manage Worklists

5.6.9 Emailing a Copy of the Form

The preferred way to share a form with another user is by using the_Forwarding option in Form
Manager. However, you may use the email option to share the form with users who do not have an
AVS account.

1. Click the Email icon on the toolbar above the form.

= H 0 P [Tz imwe & & &® [z - fSignv A i O | e -

| Y |
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2. A dialog box appears for you to select one of two options to email the document. Click the

Send Copy button to send a copy of the PDF file, including your changes, as an attachment to
your email.

x

i ] How wiowld wou like ko email this document:
* 5end a link (URL) to the ariginal, unmodified POF file on the Web?

* Send a copw of the POF file, including wour changes, as an attachment?

Send Copy Cancel

NOTE: If the Email icon is not visible, position the mouse pointer between two of the first set of
icons on the left side of the toolbar and right-click to display a drop-down menu. Then select "Email"
to display the icon on the toolbox.

I
Show/Hide Toolbars g
v =l Print
v | Save a Copy
@ Add to a Collection
¥ search
_"] Email h
Showe all Tools

Reset Toolbar

Mare Tools, ..
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5.6.10 Forwarding a Task

The Forward function can be used to forward a task to another user for review purposes,
collaboration, or assistance in completing a form. This does not submit the form or route it to the
next stage in the workflow process.

Forwarding a task can be done from either the Worklist tab or from the Task Details tab (if
applicable), as shown in the examples below.

WORKLIST

The following items need your attention before thay can be submitted or resubmitted.
Please select a form to edit

Process | Process Instructions Description | Updated Date =
|Ij Mame ] {111} e
1802 Major Mechanicl (8/27/2008 09:2] {i
Repair/Alterat submitted a Form A
icn 337 for your
(Mracking#:
2008001178)

Task Details Form Attachments (0)

337
Instructions  Fill out this form to get your repair approved.

Deadline Date

‘ : Creation Date Aug 04, 2008 - 1224255
N—/ Updated Date

Taskid 1101

Status Created

—I Description Form337

Forward this task to another user g
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1. Click the Forwarding icon to open the Forwarding window as shown below.

337 X
Task Details Form Attachments (1) Forwarding

Performa forwarding action on your Task
.{g Farward this task to anather user. Assign this task to another individual.

To locate a user, type the user's name in the text field and press enter. Select the desired user fram the listand then add the
user to the recipient list and select ok to perform the action.

Type Name and then Select from List:

Find |

Mame Phone Mumber Email

Recipient

Mame Phone Mumbear Email

2. To locate a user, type the user's name in the text field and click the Find button or press Enter
on the keyboard.

NOTE: You can enter either the first name or the last name (not both) or the format of
(lastname, firstname). User name is not case-sensitive.

3. Select the desired user from the list (see example below) and click on the Forwarding icon CE
next to the user name. The result of the search may return more than one name (i.e., for the
last name Smith). Scroll down the list and select the appropriate individual.
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33z X
Task Details Form Attachments (1) Forwarding

Performa forwarding action on your Task
L{i? Forward this task to another user. Assign this task to another individual.

To |locate a user, type the user's name in the text field and press enter. Select the desired user from the listand then add the
user to the recipient list and select ok to perform the action.

Type Name and then Select from List:

smith| | Find I

| Name | Phone Number | Email -
. ‘fi Smith, Brian brian.smm  206-812-8553 brian.smith@cargo360.aero =
Recipient
Name ' Phane Number | Email

4. Click the Add button to add the user to the Recipient list.
5. Click OK to forward the task.
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Returning a Forwarded Form
1. To return the forwarded task or form back to the sender, open the form in the Worklist.

2. On the Task Details tab, click the “Return this task to the previous user” icon on the
bottom of the window.

Aviation Safety
eForm Service - Form Manager

Preferences | 5 eForms Admin | H&Ir:n-é Logout Welcome Bowman, Cynthia

Air Carrier Certificate

Task Details Form

Air Carrier Certificate
Instructions
j Description  FAA B430-18 titled "Air Carrier Certificate”
Deadline Date
Creation Date  lan 15, 2010 - 5:55:48
Updated Date  Jan 15, 2010-10:41:15
Taskld 14909
Status  Created
Process Details
Drascription

Creation Date

Process Mame

Return this task to the previous user

3. The form disappears from your Worklist view and a yellow message bubble appears on
the top menu bar to notify you that the form has been added to the previous user’s
Worklist queue.
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5.6.11 Printing a Form

To print a form, click on the Print icon H on the toolbar above the form. Clicking on File > Print
from the main top menu bar of the Internet browser will not print the form.

ﬁ J i '% Il— jz Ik “l',' 'f_g | & & I?B.Z% - f Sign v = I:;:l :|F|nd -

| Pd |

NOTE: If the Print icon is not visible, position the mouse pointer between two icons on the left side
of the toolbar and right-click to display a drop-down menu. Then select Print to display the icon on

the toolbar.

ToW=F O B
ShowfHide Toolbars k
= Print <fu— -
v Lj Save a Copy
% #dd o a Caollection

3] search

v [ Email

Show 8l Tools

Reset Toolbar

Mare Tools, ..
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5.6.12 Changing Task Description

The description for each task can be changed (or added) while in Worklist view or in Archived
view. See examples below.

NOTE: This description is used for organizing your own Worklist and Archived views and does not
go with the task when it is sent to the next stage of the workflow process. The only exception is
when the task is forwarded to another user since the description stays only with forwarded tasks.

Changing Task Description in Worklist View

Click inside the Description section of the task and type the description in the text box.
Press Enter on the keyboard or click outside the text box when finished.

The following items need your attention before they can be submitted or resubmitted.
Flease select a form to edit

Process | Process Instructions | Diescription | Updated
Id MName 4E i [ | Date

2406 337 Mechanic | |09/23/2008 ¥ |4
submitted a Form 09:11 AM
337 foryour
approval.
(Tracking#:
2008001194) % i
2403 337 Your Form 337 (09/23/2008 ii
submission was 0B:56 A
approved by
Bowman,
Cynthia.(Tracking#:
2008007181

2407 i3y Mechanicl 09/17/2008 {’
submitted a Form 12:15 PM
337 foryour
approval.
(Trackingd:
2008001195)

[«]
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Changing Task Description in Archived View

For the Archived view, there are two ways to change the task description:

One way is by clicking inside the Description section of the task and typing the description in
the text box. Press Enter on the keyboard or click outside the text box when finished.

The following items are READ OMLY copies of completed PDF forms and are viewable
here for up to 365 days.

From 07/28/2008 H To

Process ID| Task |d

2103 3817

05/26/2008 | 74

Process Mame

Major Repair/flteration

4E i |]> Complete ¥

1 (15/23/2008 0B:46

%_AM

Another way is by double-clicking on the task in the Archived view above to open it and then

ol
selecting the Audit tab. Click once on the task and the Edit icon u appears on the left
bottom corner of the window, as shown in the example below. The Edit icon is also visible

when clicking on the View icon

&

to open the form.

Process Details Audit

| selected Task 3817

_,_S:il Tasks for Process Instance 2103

your repair approved.

Task Id |nstructions Selected Route Creation Date Completion Data
£, T BU Mechonilsbmiteds Sep04 2008135732 Sep26, 2008130456
. Form 337 foryour
It approval. reckings:
 2008001184)
@ é AETD Fillout this torm to get hE-p U, JUUE - 1353005 '_‘-E-p U, JU0E - 135778

..65 Attachments (0]
W

ﬂ Assignments for Task 3817

& Formfor Task 3817

&

-

Change the task description
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Click on the Edit icon and the "Change Task Description" window appears for you to enter
the description of the task.

Enter Mew Description

|

Click Save when done or Cancel to go back to Audit view.

5.7 Problems Accessing the System

571 Locked Account

To unlock your account, contact AVS National Service Desk at 877-287-6731 or email AVS National

Service Desk
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5.8 User Support

The eForm home page contains the User Support links on the left side of the window.

Electronic Forms
Topics

» What's New

* System
Requirements

User Support
Help Topics

Tutorials

Application Web
Sites

» Form 337 Web Site

1]

A\ Federal Aviation
4 Administration

Aviation Safety eForm Service - Home

¢ ekForm Service

The Office of Aviation Safety (AWS) provides an
electronic Form Service in support of the
Gaovernment PaperWork Elimination Act (GRPEA)
and eGEOY inttiatives  Creating and submitting
forms electronically greatly speeds up farm
processing as opposed to manual paper processing
methods,

¢ Registration

The A3 electronic Form Service user interface
(Form Manager) is a secure web-based application
and, therefore, requires a user account and
password within the AV'S daomain for access.
FAAANT ermplovees can access the system with
their A3 user account and use the available forms
within Form Manager based on that account's
permissions.

For more help with the eForm System, contact
AVS National Service Desk at: 8772876731
Email AW'S Mational Service Desk

AY¥S eForm Service Home

AWS Formn Manager Access

Log Into eFarm Serice

Get Adobe
Reader

FLASH PLAYER

Ger ADOBE _/Ei

| v
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To contact AVS National Service Desk, click on “User Support” on the home page. The following
window is displayed, which contains the phone numbers and an email link to AVS National Service
Desk.

Federal Aviation p o
e i erorm ervice nome
Administration

Aviation Safety eForm Service - User Support:

User support is available from AWS Mational Service Desk for help with many different aspects of the
eForm Service. Mational Service Desk can help with access. passwords, and some level of
application support

\Web-based on-line help and tutorials are available from the help and tutorial sections accessed from
the main eForm Senice web site

Awation Safety User Support is provided for the eForm Semvice only for specific Windows platforms

Please visit the eForms "System Requirements” page for a listing of computer hardware, software
and operating systems supported

Contact AVS Mational Service Desk at:
a77-287-6731

Email AVS Mational Serice Desk

FAA.gov Home | Privacy Policy | Web Policies & Notices | Site Map | Contact Us | Help LI
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To access the eForm Service Help Topics and the User Guide, click on “Help Topics” on the home
page. The following window is displayed, which contains the link to the Help Topics and User Guide.

Federal Aviation
Administration

Aviation Safety eForm Service - Help Topics

* eForm Service Help.

A¥S eForm Service Home

The eForm Zerice Help guides you through the diferent aspects of using eForms. It walks
vou through Form Manager, discusses general guestions, system access and much more.

e eForm Service User Guide.

Download the soft copy of the eForm Serice User Guide. |t details high-level aspects of the
Form Manager user interface. (3.44mb) (POF may apen in your browser. To prevent this,
nght chicl the link, and select "Sawve Target As.. " O yvou can open it and clicl on the

"Save a Copy" joon in the Adobe Acrabat or Reader screen.)

# eForm Service Quick Reference Guide.

Download the soft copy of the Quick Reference Guide. It details high-level aspects of the

Form Manaoer user interface.

FAA.gov Home | Privacy Policy | Web Policies & Notices | Site Map | Contact Us | Help

| »

To access the Tutorials, click on “Tutorials” on the home page. A menu page will appear with
several tutorials to choose from.

END OF DOCUMENT
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